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Studio Manager for V2 DM2000 Editor—Owner’s Manual

 

Special Notices

 

• The software and this owner’s manual are the exclu-
sive copyrights of Yamaha Corporation.

• Copying of the software or reproduction of this man-
ual in whole or in part by any means is expressly for-
bidden without the written consent of the 
manufacturer.

• Copying of the commercially available music 
sequence data and/or digital audio files is strictly pro-
hibited except for your personal use.

• Yamaha makes no representations or warranties with 
regard to the use of the software and documentation 
and cannot be held responsible for the results of the 
use of this manual and the software.

• This disc is a CD-ROM. Do not attempt to play the 
disc on an audio CD player. Doing so may result in 
irreparable damage to your audio CD player.

• The screen displays as illustrated in this owner’s man-
ual are for instructional purposes, and may appear 
somewhat different from the screens which appear on 
your computer.

• Future upgrades of application and system software 
and any changes in specifications and functions will 
be announced separately.

 

Trademarks

 

• Adobe, Acrobat, and Reader are registered trademarks of 
Adobe Systems Incorporated. Apple, AppleTalk, and 
Macintosh are registered trademarks of Apple Com-
puter, Inc. Microsoft and Windows are registered trade-
marks of Microsoft Corporation. All other trademarks 
are the property of their respective holders and are 
hereby acknowledged.

 

Copyright

 

• No part of the Studio Manager software or its docu-
mentation may be reproduced or distributed in any 
form or by any means without the prior written 
authorization of Yamaha Corporation.
© 2004 Yamaha Corporation. All rights reserved.
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Getting Started

 

To use Studio Manager, you must follow these steps:

> Start Studio Manager.

> Configure the Editor.

> Synchronize Studio Manager.

 

Starting and Setting Up Studio Manager

 

1

 

Start Studio Manager.
Windows 2000:  

 

Click the Start button, move the cursor to [Programs], then [YAMAHA Studio 
Manager], then click [Studio Manager].

 

Windows XP:  

 

Click the Start button, move the cursor to [All Programs], then [YAMAHA 
Studio Manager], then click [Studio Manager].

 

Mac OS X:  

 

Select [Applications], [YAMAHA], then [Studio Manager], then double-click [Stu-
dio Manager].

 

2

 

Select the device you want to edit.

 

The names of all installed devices are displayed in the 
Device Editor section. Select the desired device, the click 
the [Add ->] button.

The selected device name appears in the Workspace sec-
tion.

 

3

 

Specify a MIDI port.

 

Select the [MIDI Ports] tab and specify the MIDI In, Out, 
and Thru ports to which the console is connected.

 

Description of menus and buttons

 

In the event that menu and button names on the Windows system are different from those on 
the Macintosh system, this manual uses the Windows menu and button names followed by the 
Macintosh menu and button names in parentheses.

 

Note: If you plan to use the same device in the future, click 
the [Set Default] button while the appropriate device name 
is listed in the Workspace section. The next time you start 
Studio Manager, the device will be automatically selected.

Note: To activate a MIDI port in Studio Manager, you must 
also specify the MIDI port in the console’s Editor separately. 
Refer to the “Configuring the Editor” on page 4 described 
later for information on specifying a MIDI port in Editor.
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4

 

Click [OK].

 

The Studio Manager host window is displayed.

 

5

 

Double-click the icon of the console you want to edit.

 

The Editor for the console is displayed.

 

Quitting Studio Manager

 

Choose [Exit (Quit)] from the [File] menu in the host window.

If there are no unsaved changes, all windows close and Studio Manager quits. If there are unsaved 
changes, a message asking whether or not you want to save the changes appears. Click [Yes] to save 
the changes and quit, click [No] to quit, or click [Cancel] to cancel the operation. You can also quit 
Studio Manager by clicking the host window’s Close button.

Studio Manager host window
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Configuring the Editor

 

You must configure the following settings for each open Editor.

 

System Setup

 

To open the Setup window, choose [System Setup] from the [File] menu. 

Be sure to specify the Input port and Output port.

 

Input port/Output port:  

 

These pop-up menus are used to select the ports through which 
Studio Manager will communicate with your Yamaha mixing console.

 

Console Device ID:  

 

Studio Manager can control any one of up to eight Yamaha mixing con-
soles, each with its own exclusive ID. Select the ID of the console you want to control.

 

Channel Select:  

 

These options determine whether or not channel selection is linked. When the 
PC->Console option is on, selecting a channel in Studio Manager selects the same channel on the 
console. When the Console->PC option is on, selecting a channel on the console selects the same 
channel in Studio Manager.

 

Confirmation: 

 

These options determine whether or not a confirmation dialog box appears 
when storing, recalling, or patching.

 

Layer Select:  

 

These options determine whether or not Layer selection is linked. When the 
PC->Console option is on, selecting a Layer in Studio Manager selects the same Layer on the con-
sole. When the Console->PC option is on, selecting a Layer on the console selects the same Layer 
in Studio Manager.

 

Window Control from Console: 

 

This option determines whether or not using the USER 
DEFINED KEYS on the console enables you to remotely open and close the Studio Manager win-
dows.

 

Note: Specify a MIDI port (page 2) before making the following settings.

Note: Select the same MIDI ports that you specified in Step 3 as described on page 2.

Macintosh System Setup windowWindows System Setup window
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Console Setup

 

To open the Console Setup window, choose [Console Setup] from the [File] menu.

 

Surround Mode:  

 

Select a Surround mode from STEREO, 3-1, 5.1, and 6.1.

 

Pair Mode:  

 

These options determine whether the fader pair is Horizontal or Vertical.

 

Channel Copy Parameter:  

 

Select desired parameters to copy from channel to channel.

DM2000 Editor window
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Synchronizing Studio Manager

 

When Studio Manager starts up, the parameter settings on the console and the parameter settings 
in Studio Manager may be different. Therefore, you must first match the parameter settings on the 
console with those in Studio Manager. This operation is called “synchronization.” Follow the steps 
below to synchronize Studio Manager.

 

1

 

Select [Synchronize], then [Total Recall...] in the host window.

 

The following window opens.

 

2

 

Select whether you want to transfer your settings to Studio Manager, or vice versa.
To Hardware:  

 

Transfers the settings of the current Studio Manager Session to your console.

 

From Hardware:  

 

Transfers the settings of your console to the current Studio Manager Session.

 

3

 

Click [OK].

 

Offline Edit Function

 

If you do not want to synchronize your console with Studio Manager, select [Offline Edit] from the 
[Synchronization] menu of each editor. To apply your off-line edits to your console, synchronize 
the console with Studio Manager by selecting the To Hardware option.

The Offline Edit function is also activated when you click the [ONLINE]/[OFFLINE] button in the 
Master window.

 

Do not operate the console while synchronization is in progress.

Note: 
• You can synchronize the system for each Editor by choosing [Re-synchronize] from the [Syn-

chronization] menu of each Editor. At this time, the All Lib option determines whether or not 
Scene and Library data is synchronized. If you synchronize the system from the host window, 
Scene and Library data will always be synchronized.

• To protect any communication ports that are used with Studio Manager, synchronizing Studio 
Manager by selecting the To Hardware option does not affect any communication settings on 
the console (such as the MIDI, Remote Layers, and Machine Control settings).



 

U
si

ng
 S

tu
di

o 
M

an
ag

er
 

W
in

do
w

s

 

G
et

ti
n

g
 S

ta
rt

ed

 

K
ey

bo
ar

d 
S

ho
rt

cu
ts

 

In
d

ex

 

7

 

Studio Manager for V2 DM2000 Editor—Owner’s Manual

 

U
si

ng
 S

M
 W

in
do

w
s

 

Working with Sessions

 

All of your Yamaha mixing console’s mix settings in Studio Manager, including Scene and library 
data, are called Sessions. The following table describes how to handle Sessions.

If you save a Session in the host window, all selected Editor settings are saved in a file with a file 
extension of “.YSM.”

If you save a Session in an Editor, only that Editor’s settings are saved in a file.

The Editor’s settings are saved in either the Studio Manager V2 format (file extension “.YSE”) or a 
format that is compatible with earlier versions of Studio Manager (file extension varies depending 
on the console you are using).

Note that earlier versions of Studio Manager cannot open a Session saved in the “.YSE” format.

 

Undo/Redo Function

 

In Studio Manager, you can cancel the latest operation (Undo) and also cancel the cancellation of 
the latest operation (Redo). If you perform an Undo operation twice in a row, you can cancel the 
two most-recent operations. If you perform an Undo operation three times in a row, you can can-
cel the three most-recent operations. In this way, you can cancel multiple recent operations. The 
following table describes how to use the Undo/Redo function.

Please note, however, that after you perform one of the following operations, you cannot success-
fully undo or redo any previous operation:

• Closing Studio Manager

• Changing Surround mode (Stereo/3-1/5.1/6.1)

• Changing Pair mode (Horizontal/vertical)

• Synchronizing the console with Studio Manager

• Creating a new Session

• Saving a Session

• Copying and pasting a channel

• Creating or cancelling a channel pair

• Storing or recalling a scene or library

• Turning on or off the GATE: [LINK] button in the Selected Channel window

• Turning on or off the COMPRESSOR: [LINK] button in the Selected Channel window

• Turning on or off the [LINK] button in the Surround Editor window

 

Creating a new Session Choose [New (Session)] from the [File] menu.

Opening a previously saved Session Choose [Open (Session)] from the [File] menu.

Saving the current Session Choose [Save (Session)] from the [File] menu.

Saving the current Session with a new name Choose [Save (Session)] As from the [File] menu.

 

Note: In order to save the current Automix, or the settings of an optional Y56K card, in a Session, you 
must first resynchronize Studio Manager by selecting the From Hardware option.

Note: 
• If you try to create a new session in the host window or open a saved session, a message asking 

whether or not you want to save the currently-open session appears. Click [Yes] to save the current 
session and open the new or saved session. Click [No] to open the new or saved session without 
saving the current session. Click [Cancel] to cancel the operation.

• Studio Manager may be unable to open some files stored in SmartMedia. In this case, copy those 
files onto a hard disk, then try to open them in Studio Manager.

 

Undo Choose [Undo] from the [Edit] menu.

Redo Choose [Redo] from the [Edit] menu.
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• Changing Aux Send mode (Fixed/variable) on the console

• Starting automix recording or playback on the console

• Changing the sampling frequency (operated on the device)

• Changing the User Assignable Layer settings (operated on the device)

 

Other Functions

 

Copy & Paste Function

 

You can copy and paste not only the characters but the control positions in Studio Manager.

In the Console Setup window (page 5), you can also specify the parameters to be copied.

The following table describes how to use the Copy & Paste function.

 

Resetting to the default value (Ctrl ( ) + click)

 

Move the cursor to a control or a parameter value, then hold down the <Ctrl> key ( ) and click 
the mouse button to reset the value to the default (e.g., to reset an Input Channel fader to –

 

∞

 

, or 
reset a pan setting to Center).

 

Ctrl( )+Shift+Click

 

Move the cursor to a fader or AUX Send control, then hold down the <Ctrl> key ([ ]) and 
<Shift> key and click the mouse button to reset the value to the nominal level.

 

Note: You cannot Undo or Redo the following operations:
• Edits in the Setup window
• Synchronization
• Opening and closing the windows
• Resizing the windows

Note: In the Library window, you can Undo or Redo only the most recent operation. You cannot cancel 
the preceding operations.

 

Copying characters
Select copy source characters, right-click (<control>+click), then choose 
[Copy].

Pasting characters
Move the cursor to the copy destination, right-click (<control>+click), then 
choose [Paste].

Copying a channel Right-click (<control>+click) a copy source channel, then choose [Copy].

Pasting a channel
Right-click (<control>+click) the copy destination channel, then choose 
[Paste].
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Using Studio Manager Windows

 

Master Window

 

The Master window enables you to switch between layers and control Stereo Out sig-
nals. To open this window, choose [Master] from the [Windows] menu.

 

A

 

[ONLINE]/[OFF LINE] button

 

Repeatedly clicking this button toggles between online and offline status.

 

This indicator is displayed when Studio Manager is connected to 
the DM2000 correctly. If the connection is correct, the Studio Man-
ager parameters will work in unison with the DM2000 parameters.

This indicator is displayed when Studio Manager is not connected or 
is not communicating with the DM2000, or when you have selected 
Offline Edit. If the connection is incomplete, the Studio Manager 
parameters will not work in unison with the DM2000 parameters.

 

B

 

Meters

 

These meters display the output level of the 
Stereo Out when Surround mode is set to 
“STEREO,” or the Bus Outs used for sur-
round processing when Surround mode is 
set to 3-1, 5.1 or 6.1. The meters in 3-1, 5.1 
and 6.1 Surround modes are shown on the 
right.

 

C

 

LAYER buttons

 

These buttons are used to select the Layers.

 

D

 

PAN CONTROL

 

These buttons are used to select either 
“STEREO” (Stereo mode) or “SURR” (Sur-
round mode). The Pan control on the Input 
Channels is a rotary control when “STEREO” is selected, and a dot on a pan 
graph when “SURR” is selected.

 

E

 

Scene number display

 

This display indicates the currently-recalled scene’s number.

 

F

 

[AUTO] button

 

This button displays the Automix status of the Stereo Out.

 

G

 

[SELECT] button

 

This button is used to select the Stereo Out.

 

H [ON] button
This button turns the Stereo Out on and off. It appears orange while the Stereo 
Out is on.

I Master fader
This is the Stereo Out fader.

J Fader value indicator
This indicator indicates the fader position in decibels (dB).

Note: If Studio Manager is not connected or is not communicating with the 
DM2000, clicking this button will not switch the unit from offline to online.

2

1

3

4

5

6
7

8

9

J

3-1 5.1 6.1
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Layer Windows
The DM2000 Editor’s Layer window displays 24 channel strips. You can select a layer using the LAYER 
buttons in the Master window. To open the Layer window, choose [Layer] from the [Windows] menu.

Input Channels
Selecting the 1-24, 25-48, 49-72, or 73-96 LAYER button in the Master window displays 
the corresponding Input Channel strips.

A SOURCE parameter
This parameter is used to select an Input source. To select an Input source, click the 
parameter and choose from the list that appears.

B Routing buttons
These buttons are used to route the Input Channel to the Bus Outs.

C [STEREO] button
This button is used to route the Input Channel’s signal to the Stereo Out.

D [DIRECT] button
This button turns on and off the Input Channel’s routing to its Direct Out.

E Direct Out parameter
This parameter is used to select the Direct Out destination. To select a destination, 
click the parameter and choose from the list that appears.

F [PHASE] button
This button is used to reverse the signal phase of the channel.

G [INSERT] button
This button is used to turn on and off the Input Channel’s Insert.

H [GATE] button
This button is used to turn on and off the Input Channel’s Gate.

I Gate open/close indicators
These indicators display whether the Gate is open (green) or closed (red).

J Gate threshold
This displays the Gate Threshold, which can be set by dragging.

K [COMP] button
This button is used to turn on and off the Input Channel’s Compressor.

L Compressor curve
This display shows the Compressor’s curve.

M [EQ] button
This button is used to turn on and off the Input Channel’s EQ.

N EQ curve
This display shows the Equalizer’s curve, which can be set by dragging.

O [DELAY] button
This button is used to turn on and off the Input Channel’s Delay function.

P Delay parameter
This parameter is used to set the delay time of the Delay function. Delay times can be 
set by dragging.

Note: 
• You can selectively turn on or off some of channel strips by using the [View] menu.
• You can open multiple Layer windows. The second and subsequent open windows will indicate 

“Locked” in the title, which means that these windows do not reflect layer selections made on the console 
or in the Master window. If you want the Layer windows to reflect the changes, right-click each window 
(Macintosh: <control> + click), then select the desired layer using the LAYER buttons.

A

B

C
D
E

F
G

H
I

J
K

L

M

N

O
P
Q

R

S

T

V
W
X

Y
Z

a
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Q Channel number
This is the channel number. Double-click the channel number to open the Selected 
Channel window.

R AUX section
These controls are used to set the levels of the Aux Sends. To set an Aux 
Send level, drag its bar or click a point along the length of the bar. To turn 
an Aux Send on or off, click its number.

The following table shows how the Aux Send controls appear depending 
on the Aux Send On/Off and Pre/Post settings. Aux Sends can be set to 
pre-fader or post-fader on the Selected Channel window (see “AUX 
SEND section” on page 15).

S Pan/Aux Send display
This display shows the stereo or surround pan position or, while setting an Aux Send, 
the Aux Send level in dB.

T PAN control
This control is used to set the Input Channel’s stereo or surround pan position. 
When the PAN CONTROL in the Master Window is set to “STEREO,” the Pan con-
trol appears as a rotary control, and when set to “SURR,” the control appears as dot 
on a pan graph. The surround pan position can be set by dragging the dot. 

U LFE control
When 5.1 or 6.1 Surround mode is selected, this control is used to set the 
surround LFE Channel level. It appears when the PAN CONTROL in the 
Master Window is set to “SURR.” To set the Channel level, drag the end of 
its bar or click a point along the length of the bar.

V [AUTO] button
This button displays the Automix status of the Input Channel.

W [SELECT] button
This button is used to select the Input Channel.

X [SOLO] button
This button solos the Input Channel. It appears orange while the channel is soloed.

Y [ON] button
This button turns the Input Channel on and off. It appears orange while the channel 
is on.

Z Short channel name
This is the channel’s short name. To edit the name, click it and type.

a Channel fader and channel meter
This is the Input Channel fader. The channel meter to the right of the fader displays 
the Input Channel signal level.

b Fader value indicator
The fader value indicator indicates the fader position in decibels (dB).

A

B

C
D
E

F
G

H
I

J
K

L

M

N

O
P
Q

R

S

T

V
W
X

Y
Z

a

b

Aux Send status Appearance

On or off but no level set Dark blue bar

Off, pre-fader Green bar outline displays level

On, pre-fader Green bar displays level

Off, post-fader Orange bar outline displays level

On, post-fader Orange bar displays level

U
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Output Channels
When you select the Master LAYER button in the Master window, the Bus Out, Aux 
Send, and Matrix Send channels are displayed. The Aux Send and Matrix Send chan-
nels appear the same as the Bus Out channels except that the Bus Out channels fea-
ture a [STEREO] button.

A [STEREO] button (Bus Out only)
This button is used to route the Bus Out to the Stereo Out.

B [INSERT] button
This button is used to turn on and off the Bus Out’s Insert.

C [COMP] button
This button is used to turn on and off the Bus Out’s Compressor.

D Compressor curve
This display shows the Compressor’s curve.

E [EQ] button
This button is used to turn on and off the Bus Out’s EQ.

F EQ curve
This display shows the Equalizer’s curve, which can be set by dragging.

G [DELAY] button
This button is used to turn on and off the Bus Out’s Delay function.

H Delay parameter
This parameter is used to set the delay time of the Delay function. Delay times 
can be set by dragging.

I Channel number
This is the channel number. Double-click the channel number to open the 
Selected Channel window.

J [AUTO] button
This button displays the Automix status of the Bus Out.

K [SELECT] button
This button is used to select the Bus Out. Clicking this button again in a Matrix 
Send channel strip will switch to L or R.

L [SOLO] button
This button solos the Bus Out. It appears orange while the Bus Out is soloed.

M [ON] button
This button turns the Bus Out on and off. It appears orange while the Bus Out is 
on.

N Short channel name
This is the channel’s short name. To edit the name, click it and type.

O Channel fader and channel meter
This is the Bus Out fader. The meter to the right of the fader displays the Bus Out 
signal level.

P Fader value indicator
The fader value indicator indicates the fader position in decibels (dB).

G
H

A

B

C

D

E

I

J

L

N

P

O

F

K

M
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Remote Channels
When you select one of the Remote layers REMOTE1, REMOTE2, REMOTE3, or 
REMOTE4 using the LAYER button in the Master window, Remote Channels are 
displayed.

A Channel number
This is the channel number. Double-click the channel number to open the 
Selected Channel window.

B [SELECT] button
This button is used to select the Remote Channel.

C [ON] button
This button turns the Remote Channel on and off. It appears orange while the 
channel is on.

D Remote target name
This name indicates the remote target assigned on the DM2000.

E Channel fader
This is the Bus Out’s fader. 

F Fader value indicator
This indicator indicates the fader position in the range of 0 through 127.

If the remote target is set to User Assignable Layer:
In this case, the assigned channels are displayed. For more information, refer to 
“Input Channels” on page 10 and “Output Channels” on page 12. If the Group Mas-
ter Fader is assigned, only the [AUTO], [SOLO], and [ON] buttons and channel fad-
ers are displayed.

Note: When the remote target setting on the DM2000 is set to User Defined, you 
can use the [ON] buttons and channel faders to control the functions specified on 
the Remote 1-4 pages.

Note: When the remote target setting on the DM2000 is set to User Defined, you 
can use the [ON] buttons and channel faders to control the functions specified on 
the Remote 1-4 pages.

A

B

C
D

F

E
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Selected Channel Window
The Selected Channel window allows detailed editing of the currently selected channel. To open the 
Selected Channel window, choose [Selected Channel] from the [Windows] menu.

There are six variations of the layout of the Selected Channel window, as follows:

• Input Channels (see below)

• Bus Outs (see page 16)

• Aux Sends (see page 17)

• Matrix Sends (see page 18)

• Stereo Outs (see page 19)

• Remote Channels (see page 20)

Input Channels

A CHANNEL SELECT, INPUT PATCH & LIBRARY section
Channels can be selected by clicking the Channel ID and selecting from the list that appears, or by 
clicking the left and right Channel Select buttons. The long channel name is displayed below the Chan-
nel ID. To edit the name, click it and type. The INPUT PATCH parameter is used to select an input 
source. To select an input, click the parameter and choose from the list that appears. The [LIBRARY] 
button opens the Channel Library window.

BGATE section
This section contains the Gate controls and display graph for the currently selected Input Channel. 
The rotary controls are used to set the threshold, range, attack, decay, and hold. The GR meter indi-
cates the amount of gain reduction being applied by the Gate. The [ON] button turns the Gate on and 
off. The [LINK] button links the Gate of the currently selected Input Channel with the Gate of its part-
ner channel. The KEY IN parameter is used to select a Gate trigger source. The [LIBRARY] button 
opens the Gate Library window.

Note: You can open multiple Selected Channel windows. The second and subsequent open 
windows will indicate “Locked” in the title, which means that you cannot open Library 
windows from these windows. In addition, these windows will not reflect the following 
edits:
• Channel selections made in the Layer window (via the SELECT button)
• Edits in the Surround Editor window

A B DC E F

G H I
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C EQUALIZER section
This section contains the EQ controls and display graph for the currently selected Input Channel. The 
rotary controls are used to set the gain, center frequency, and Q of each band, and the pre-EQ attenuation 
level. EQ can also be set by dragging the EQ curve on the EQUALIZER graph. The [ON] button turns the 
EQ on and off. The TYPE buttons select the EQ type. The [LIBRARY] button opens the Equalizer Library 
window.

DDELAY & PHASE section
This section contains the delay and phase controls for the currently selected Input Channel. The rotary 
controls are used to set the delay time, feedback gain, and mix balance (wet/dry balance). The [ON] 
button turns the Delay on and off. The [PHASE] button reverses the channel’s signal phase.

E ROUTING, PAN & level section
This section contains the routing, pan, and level controls and the [AUTO], [SOLO], and [ON] buttons 
for the currently selected Input Channel. ROUTING buttons 1–8 are used to route the channel to the 
Bus Outs. The [STEREO] button routes the channel to the Stereo Out. The [DIRECT] button routes 
the channel to its Direct Out, and the Direct Out parameter below it selects a Direct Out destination. 
The [F.PAN] button turns on and off the Bus Out Follow Pan function. The PAN control is used to 
pan the channel. The [AUTO] button displays the Automix status. The [SOLO] button is used to solo 
the channel, the [ON] button, to turn on and off the channel, and the channel fader, to set the channel 
level. The meter to the right of the fader indicates the signal level, and the value indicator under the 
fader indicates the fader position in decibels (dB).

F AUX SEND section
This section contains the Aux Send controls for the currently selected Input Channel. Use the rotary 
controls to set the Aux Send levels, and click them to turn Aux Sends on and off. Use the button below 
each Aux Send control to select pre-fader or post-fader. In Fixed mode, this button is used to turn Aux 
Sends on and off (the level is fixed at nominal).

When Aux Sends are paired, a heart icon is displayed between them, and the odd-numbered Aux Send 
control sets the level, while the even-numbered control works as a pan control.

G INSERT section
This section contains the Insert parameters for the currently selected Input Channel. The [ON] button 
turns the Insert on and off. The OUT and IN parameters are used to specify the insert out destination 
and insert in source respectively. The POSITION parameter is used to specify the position of the Insert 
in the signal path.

H COMPRESSOR section
This section contains the Compressor controls and display graph for the currently selected Input 
Channel. The rotary controls are used to set the threshold, ratio, attack, release, gain, and knee. The 
GR meter indicates the amount of gain reduction being applied by the Compressor. The OUT meter 
indicates its output level. The [ON] button turns the Compressor on and off. The [LINK] button links 
the Compressor of the currently selected Input Channel with the Compressor of its partner channel. 
The POSITION parameter is used to specify the position of the Compressor in the signal path. The 
ORDER parameter is used to specify the order of the Compressor and Insert when both are inserted 
at the same position. The [LIBRARY] button opens the Compressor Library window.

I PAIR, FADER GROUP & MUTE GROUP section
This section contains the Pair, Fader and Mute group functions for the currently selected 
Input Channel. Click the heart icon to pair and unpair the channel with its partner channel. 
Use the FADER GROUP buttons to add the channel to Fader groups, and use the MUTE 
GROUP buttons to add it to Mute groups.
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Bus Outs

A CHANNEL SELECT section
Channels can be selected by clicking the Channel ID and selecting from the list that appears, or by 
clicking the left and right Channel Select buttons. The long channel name is displayed below the Chan-
nel ID. The [LIBRARY] button opens the Channel Library window.

B EQUALIZER section
This section contains the EQ controls and display graph for the currently selected Bus Out. It’s layout 
is identical to the EQUALIZER section for Input Channels. See “EQUALIZER section” on page 15 for 
more information.

CDELAY section
This section contains the delay controls for the currently selected Bus Out. The rotary control is used 
to set the delay time, and the [ON] button turns the Delay function on and off.

D TO STEREO & level section
This section contains the TO STEREO, pan and level controls and the [AUTO], [SOLO], and [ON] 
buttons for the currently selected Bus Out. The TO STEREO button routes the Bus Out to the Stereo 
Out, and the rotary controls are used to set the Bus to Stereo send level and pan. The [AUTO] button 
displays the Automix status. The [SOLO] button is used to solo the Bus Out, the [ON] button, to turn 
the Bus Out on and off, and the channel fader, to set the Bus Out level. The meter to the right of the 
fader indicates the signal level, and the value indicator under the fader indicates the fader position in 
dB.

E INSERT section
This section contains the Insert parameters for the currently selected Bus Out. The [ON] button turns 
the Insert on and off. The OUT and IN parameters are used to select the insert out destination and 
insert in source respectively. The POSITION parameter is used to specify the position of the Insert in 
the signal path.

F COMPRESSOR section
This section contains the Compressor controls and display graph for the currently selected Bus Out. 
Its layout is identical to the COMPRESSOR section for Input Channels. See “COMPRESSOR section” 
on page 15 for more information.

G PAIR, FADER GROUP & MUTE GROUP section
This section contains the Pair, Fader and Mute group functions for the currently selected 
Bus Out. Click the heart icon to pair and unpair the channel with its partner channel. Use 
the FADER GROUP buttons to add the channel to Fader groups, and use the MUTE 
GROUP buttons to add it to Mute groups.

A CB D
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Aux Sends

A CHANNEL SELECT section
Channels can be selected by clicking the Channel ID and choosing from the list that appears, or by 
clicking the left and right Channel Select buttons. The long channel name is displayed below the Chan-
nel ID. The [LIBRARY] button opens the Channel Library window.

B EQUALIZER section
This section contains the EQ controls and display graph for the currently selected Aux Send. It’s layout 
is identical to the EQUALIZER section for Input Channels. See “EQUALIZER section” on page 15 for 
more information.

CDELAY section
This section contains the delay controls for the currently selected Aux Send. The rotary control is used 
to set the delay time, and the [ON] button turns the Delay function on and off.

D Aux Send level section
This section contains the [AUTO], [SOLO], and [ON] buttons and the channel fader for the currently 
selected Aux Send. The meter to the right of the fader indicates the signal level, and the value indicator 
under the fader indicates the fader position in decibels (dB).

E INSERT section
This section contains the Insert parameters for the currently selected Aux Send. The [ON] button 
turns the Insert on and off. The OUT and IN parameters are used to specify the insert out destination 
and insert in source respectively. The POSITION parameter is used to specify the position of the Insert 
in the signal path.

F COMPRESSOR section
This section contains the Compressor controls and display graph for the currently selected Aux Send. 
Its layout is identical to the COMPRESSOR section for Input Channels. See “COMPRESSOR section” 
on page 15 for more information.

G PAIR, FADER GROUP & MUTE GROUP section
This section contains the Pair, Fader and Mute group functions for the currently selected 
Aux Send. Click the heart icon to pair and unpair the channel with its partner channel. Use 
the FADER GROUP buttons to add the channel to Fader groups, and use the MUTE 
GROUP buttons to add it to Mute groups.

A CB D

E F G
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Matrix Sends

A AUX section
This section contains the Aux Send-to-Matrix Send controls for the currently selected Matrix Send. 
The rotary controls are used to set the Aux Send-to-Matrix Send level and pan. A heart icon is dis-
played between paired Aux Sends.

B BUS section
This section contains the Bus Out-to-Matrix Send controls for the currently selected Matrix Send. The 
rotary controls are used to set the Bus Out-to-Matrix Send levels and pan. A heart icon is displayed 
between paired Bus Outs.

C CHANNEL SELECT section
Channels can be selected by clicking the Channel ID and choosing from the list that appears, or by 
clicking the left and right Channel Select buttons. The long channel name is displayed below the Chan-
nel ID. The [LIBRARY] button opens the Channel Library window.

D EQUALIZER section
This section contains the EQ controls and display graph for the currently selected Matrix Send. It’s lay-
out is identical to the EQUALIZER section for Input Channels. See “EQUALIZER section” on page 15 
for more information.

EDELAY section
This section contains the delay controls for the currently selected Matrix Send. The rotary control is 
used to set the delay time, and the [ON] button turns the Delay function on and off.

FMatrix Send level section
This section contains the balance control, [AUTO], [SOLO], and [ON] buttons and the channel fader 
for the currently selected Matrix Send. The meter to the right of the fader indicates the signal level, and 
the value indicator under the fader indicates the fader position in decibels (dB).

G STEREO section
This section contains the Stereo Out-to-Matrix Send controls for the currently selected Matrix Send. 
The rotary controls are used to set the Stereo Out-to-Matrix Send level and pan.

C ED F

HG I
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H INSERT section
This section contains the Insert parameters for the currently selected Matrix Send. The [ON] button 
turns the Insert on and off. The OUT and IN parameters are used to specify the insert out destination 
and insert in source respectively. The POSITION parameter is used to specify the position of the Insert 
in the signal path.

I COMPRESSOR section
This section contains the Compressor controls and display graph for the currently selected Matrix 
Send. Its layout is identical to the COMPRESSOR section for Input Channels except there is no 
[LINK] button. See “COMPRESSOR section” on page 15 for more information.

J FADER GROUP & MUTE GROUP section
This section contains the Fader and Mute group functions for the currently selected Matrix Send. Use 
the FADER GROUP buttons to add the channel to Fader groups, and use the MUTE GROUP buttons 
to add it to Mute groups.

Stereo Out

A CHANNEL SELECT section
Channels can be selected by clicking the Channel ID and choosing from the list that appears, or by 
clicking the left and right Channel Select buttons. The long channel name is displayed below the Chan-
nel ID. The [LIBRARY] button opens the Channel Library window.

B EQUALIZER section
This section contains the EQ controls and display graph for the Stereo Out. It’s layout is identical to 
the EQUALIZER section for Input Channels. See “EQUALIZER section” on page 15 for more infor-
mation.

CDELAY section
This section contains the delay controls for the Stereo Out. The rotary control is used to set the delay 
time, and the [ON] button turns the Delay function on and off.

D Balance & level section
This section contains the balance control, [AUTO] and [ON], and channel fader for the Stereo Out. 
The meter to the right of the fader indicates the signal level, and the value indicator under the fader 
indicates the fader position in decibels (dB).

A CB D
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E INSERT section
This section contains the Insert parameters for the Stereo Out. The [ON] button turns the Insert on 
and off. The OUT and IN parameters are used to specify the insert out destination and insert in source 
respectively. The POSITION parameter is used to specify the position of the Insert in the signal path.

F COMPRESSOR section
This section contains the Compressor controls and display graph for the currently selected Stereo Out. 
Its layout is identical to the COMPRESSOR section for Input Channels except there is no [LINK] but-
ton. See “COMPRESSOR section” on page 15 for more information.

G FADER GROUP & MUTE GROUP section
This section contains the Fader and Mute group functions for the Stereo Out. Use the FADER GROUP 
buttons to add the Stereo Out to Fader groups, and use the MUTE GROUP buttons to add it to Mute 
groups.

Remote Channels
If the remote target is set to User Assignable Layer, the assigned channels are displayed. For more infor-
mation, refer to “Input Channels” on page 10 and “Output Channels” on page 12. If the Group Master 
Fader is assigned, only the [AUTO], [SOLO], and [ON] buttons and channel faders are displayed.
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Library Window
The Library window enables you to control and manage Scenes and libraries. In addition, Scenes and 
libraries can be saved to disk on your computer as Library files.

To open the Library window, choose [Library] from the [Windows] menu. The Library window con-
sists of 10 display pages. You can access each of these pages by clicking the tabs along the top of the 
window, or by following the action described below:

The layout of the Library window pages is the same regardless of which page is selected (the Scene 
Memory library is shown below). The Library window consists of two panes. The pane on the left, 
called the [FILE] section, displays the status of the currently open library file. The pane on the right, 
called the [INTERNAL DATA] section, displays the status of the corresponding library in the console.

You can copy and sort the items in the list (memories) by dragging them between the panes. Within 
the same pane, you can copy a memory by dropping it on top of another memory, and you can sort 
memories by dropping a memory between two memories. Memory contents can be swapped by hold-
ing down the <Shift> key while dragging. In all cases, the contents of the destination memory are 
overwritten. To edit a memory title, click the title, then type.

Library page Action

Channel Library

[LIBRARY] buttons on the Selected Channel window
Gate Library

Compressor Library

Equalizer Library

Input Patch Library
[LIBRARY] button on the Patch Editor window

Output Patch Library

Effect Library [LIBRARY] buttons on the Effect Editor window

GEQ Library [LIBRARY] buttons on the GEQ Editor window

A
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A File name
This is the file name of the currently open Library file.

B [OPEN] button
This button is used to open Library files.

C [CLOSE] button
This button is used to close the currently open Library file.

D [SAVE] button
This button is used to save the currently open Library file.

E [SAVE AS] button
This button is used to save the currently open Library file with a different name.

F TITLE
This column displays the memory titles.

G PROTECT (only for Scene memories and Automix memories)
This column displays padlock icons for protected memories. It also displays an “ ” (read-only) icon 
for preset data.

H INPUT PATCH LINK (only for Scene memories)
This column displays the input patch memory numbers linked to the Scene library. When you store 
or recall a Scene memory, the linked Input Patch Library memory is stored or recalled at the same 
time.

IOUTPUT PATCH LINK (only for Scene memories)
This column displays the Output Patch memory numbers linked to the Scene library. When you store 
or recall a Scene memory, the linked Output Patch Library memory is stored or recalled at the same 
time.

J [STORE] button
This button is used to store the contents of the library to the specified location.

K [RECALL] button
This button is used to recall the selected memory.

L [FILE] section
This section displays the contents of the currently open library file.

M [INTERNAL DATA] section
This section displays the console’s status of the currently selected library.

N [CLEAR] button
This button clears the selected memory from the list.

O [UNDO] button
This button undoes the last recall, store, copy, clear, sort or titling operation.

P [PROTECT] button (only for Scene memories and Automix memories)
This button is used to protect or unprotect the selected memory.

Note: Studio Manager may be unable to open some files stored in SmartMedia. In this case, copy those 
files onto a hard disk, then try to open them in Studio Manager.

Note: You cannot store Automix memories during offline editing.

Note: You cannot recall Automix memories during offline editing.

Note: If the OFFLINE indicator is selected by the [ONLINE]/[OFFLINE] button in the Master window, 
Studio Manager is not synchronizing with the console. Therefore, this section does not display the console’s 
correct status.

Note: In the Library window, you can undo only the most recent operation. You cannot undo any oper-
ations performed prior to the most recent operation.
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Patch Editor Window
The Patch Editor window is used to patch Inputs, Outputs, Inserts, Effects, and Direct Outs. To open 
this window, choose [Patch Editor] from the [Windows] menu. This window consists of five pages, 
which you can select by clicking the tabs along the top of the window.

INPUT PATCH Page

A Channel IDs
These are the Channel IDs.

B Long channel names
These are the Channel long names. To edit a name, click it and type.

C [AUTO SETUP] button
Clicking this button sets the patches on this page to their initial values.

D [ALL CLEAR] button
This button clears all patches on this page.

E [LIBRARY] button
This button opens the Input Patch Library window.

F Port names
These are the Port names. To edit a name, click it and type.

G Patchbay
The patchbay is used to patch input ports to Input Channels. Active patches are indicated by a blue 
dot. To make a patch, click a square. To unpatch, click a blue dot.

Note: You can also use the cursor keys and the <ENTER> key on the computer keyboard to make a patch.

BA C D E

G

F
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OUTPUT PATCH Page

A Channel IDs
These are the Channel IDs.

B Long channel names
These are the Channel long names. To edit a name, click it and type.

C [AUTO SETUP] button
Clicking this button sets the patches on this page to their initial values.

D [ALL CLEAR] button
This button clears all patches on this page.

E [LIBRARY] button
This button opens the Output Patch Library window.

F Port names
These are the Port names. To edit a name, click it and type.

G Patchbay
The patchbay enables you to patch output ports to Output Channels. Active patches are indicated by 
a red dot. To make a patch, click a square. To unpatch, click a red dot.

Note: You can also use the cursor keys and the <ENTER> key on the computer keyboard to make a patch.

BA C D E
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INSERT PATCH Page

A Channel IDs
These are the Channel IDs.

B Long channel names
These are the Channel long names. To edit a name, click it and type.

C [LIBRARY] buttons
These buttons open the Input and Output Patch Library windows.

D Port names
These are the Port names. To edit a name, click it and type.

E Insert Out Patchbay
This patchbay is used to patch output ports to the Insert Outs of Input Channels, Bus Outs, Aux Sends, 
Matrix Sends, and the Stereo Out. Active patches are indicated by a red dot. To make a patch, click a 
square. To unpatch, click a red dot.

F Insert In Patchbay
This patchbay is used to patch input ports to the Insert Ins of Input Channels, Bus Outs, Aux Sends, 
Matrix Sendes, and the Stereo Out. Active patches are indicated by a blue dot. To make a patch, click 
a square. To unpatch, click a blue dot.

Note: You can also use the cursor keys and the <ENTER> key on the computer keyboard to make a patch.

B C

E F

D
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EFFECT PATCH Page

A Effects processor 1 section
This section indicates the effects name assigned to internal Effects processor 1. The parameters in this 
section are used to select inputs and outputs for Effects processor 1.

B [LIBRARY] button
This button opens the Input Patch Library window.

C Effects processor 2 section
This section indicates the effects name assigned to internal Effects processor 2. The parameters in this 
section are used to select inputs and outputs for Effects processor 2.

D Effects processors 3–8 section
This section indicates the effects names assigned to internal Effects processors 3–8. The parameters in 
this section are used to select inputs and outputs for Effects processors 3–8.

A B

C D
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DIRECT OUT PATCH Page

A Channel IDs
These are the Channel IDs.

B Long channel names
These are the Channel long names. To edit a name, click it and type.

C [LIBRARY] button
This button opens the Output Patch Library window.

D Port names
These are the Port names. To edit a name, click it and type.

E Patchbay
The patchbay is used to patch output ports to the Direct Outs. Active patches are indicated by a red 
dot. To make a patch, click a square. To unpatch, click a red dot.

Note: You can also use the cursor keys and the <ENTER> key on the computer keyboard to make a patch.
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Surround Editor Window
The Surround Editor window enables you to edit the surround pan position of the currently selected 
Input Channel. To open the Surround Editor window, choose [Surround Editor] from the [Win-
dows]menu.

A CHANNEL SELECT section
Channels can be selected by clicking the Channel ID and selecting from the list that appears, or by 
clicking the left and right Channel Select buttons. The long channel name is displayed below the Chan-
nel ID. To edit the name, click it and type.

B Surround pan graph
The green dot on this graph indicates the surround pan position for the currently selected Input Chan-
nel. The surround pan can be set by dragging the dot. Clicking a speaker icon will move the pan posi-
tion to the position of that icon.

C Surround pan position
This is the current surround pan position.

D SURROUND MODE parameter
Click this parameter to display the option list and set Surround mode to STEREO, 3-1, 5.1, or 6.1.

E [LFE] control
This rotary control sets the level of the LFE channel.

F [DIV.F] control (6.1)/[DIV] control (3-1, 5.1)
This rotary control sets the amount of divergence (i.e., how the Center signal is fed to the Left, Right, 
and Center channels). With 6.1 surround, you can set the divergence for both the front and rear. The 
[DIV.F] control sets the amount of divergence for the front signal.

G [DIV.R] control (6.1 only)
This rotary control sets the amount of divergence for the rear signal.

H [LINK] button (6.1 only)
This button is used to link the [DIV.F] and [DIV.R] controls.
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Timecode Counter Window
The Timecode Counter window displays the current timecode position in hours, minutes, seconds, 
and frames — or measures, beats, and MIDI clocks — depending on the specified timecode source. It 
works in unison with the timecode counters on the DM2000 Automix Main page.

To open the Timecode Counter window, choose [Timecode Counter] from the [Windows] menu.

Effect Editor Window
The Effect Editor window enables you to edit the internal effects processors. To open the Effect Editor 
window, choose [Effect Editor] from the [Windows] menu.

A Effects processor select
These buttons are used to select the internal effects processors.

B Effect select section
The EFFECT NAME, TYPE, and IN/OUT are the name, type and I/O configuration of the effect 
recalled to the currently selected effects processor. To edit the EFFECT NAME, click it and type. The 
[LIBRARY] button opens the Effects Library window.

C [IN] button
This button is used to set the metering position to the effects processor’s inputs.

D [OUT] button
This button is used to set the metering position to the effects processor’s outputs.

EMeters
These are output meters for the currently selected effects processor.

Note: You can open multiple Effect Editor windows. The second and subsequent open windows will indi-
cate “Locked” in the title, which means that you cannot open Library windows from these windows.
Note: When you recall effects, windows that do not indicate “Locked” in the title will be recalled.

    hour            minute         second          frame                    measure                  beat        MIDI clock

A B 53 4
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F Effect parameter section
This section contains the various effects controls, buttons, and displays. Its layout depends on the 
selected effect type.

G [MIX BALANCE] control
This control enables you to adjust the balance between the wet and dry signals. When set to 0, only the 
dry signal is heard. When set to 100, only the wet signal is heard.

H [BYPASS] button
This button is used to bypass the currently selected effects processor.

Meter Window
The Meter window displays the Input, Output, Effect, and Stereo Out meters. To open the Meter win-
dow, choose [Meter] from the [Windows] menu. This window consists of five display pages. You can 
access these pages by clicking the tabs along the top of the window.

The layout of the Meter window pages is the same regardless of the page selected. (The Master page is 
shown below.)

A Meter mode
You can select the type of meters to be displayed from the following options:

GATE GR: The meters indicate the amount of gain reduction being applied by the channel Gate.

COMP GR: The meters indicate the amount of gain reduction being applied by the channel 
Compressor.

LEVEL: The meters indicate the channel level.

B POSITION parameter
This parameter, available only when Meter mode is set to Level, enables you to select the metering 
position in the signal path.

Page Function

CH1-96 page This page displays the Input Channel 1-96 meters (12 segments).

MASTER page
This page displays the Bus 1-8, Aux 1-12, Matrix 1-4, and Stereo meters (12 seg-
ments).

Effects 1-8 page
This page displays the Channel 1 & 2 input/output meters (12 segments) for Effects 
1-8.

Effects 1-2 page
This page displays the Channels 1-8 input/output meters (12 segments) of Surround 
Effects modules.

Stereo page This page displays a bar graph (32 segments) of signal levels output to the Stereo Out.

A 2 3
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C PEAK HOLD button
This button turns the Peak Hold function on and off.

GEQ Editor Window
The GEQ Editor window enables you to edit the Graphic Equalizer (GEQ). To open this window, 
choose [GEQ Editor] from the [Windows] menu.

A MODULE parameter
This parameter is used to select the GEQs. 

B INSERT parameter
This parameter is used to select the insertion point for the currently selected GEQ.

C LINK buttons
These buttons are used to link the currently selected GEQ with other GEQs. When you click a button, 
the settings of the currently selected GEQ are copied to the other GEQ. The buttons of GEQs that are 
already linked are unavailable. 

DGEQ display
This displays the settings of the currently selected GEQ.

E LIBRARY button
This button opens the GEQ Library window.

FGEQ [ON] button
This button is used to turn on and off the currently selected GEQ. It appears green when the GEQ is 
on.

GGEQ controls
These sliders are used to boost and cut the level of each band.

H LIMIT buttons
These buttons determine the maximum amount of boost and cut for the currently selected GEQ.

I EQ FLAT button
This button resets all sliders to 0 dB.

A 2 3 5 64
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Keyboard Shortcuts

Menu Action Windows Macintosh

File menu

Creates a new Session Ctrl+N +N

Opens a previously saved Session Ctrl+O +O

Saves the current Session Ctrl+S +S

Edit menu
Undo Ctrl+Z +Z

Redo Ctrl+Y +Y

Windows menu

Closes the active window Ctrl+W +W

Closes all windows Ctrl+Alt+W +Option+W

Opens the Master window Ctrl+1 +1

Opens the Layer window Ctrl+2 +2

Opens the Selected Channel window Ctrl+3 +3

Opens the Library window Ctrl+4 +4

Opens the Patch Editor window Ctrl+5 +5

Opens the Surround Editor window Ctrl+6 +6

Opens the Timecode Counter window Ctrl+7 +7

Opens the Effect Editor window Ctrl+8 +8

Opens the Meter window Ctrl+9 +9

Opens the GEQ window Ctrl+0 +0

Library window

Selects consecutive multiple items (memories) Shift+click shift+click

Selects non-consecutive multiple items (memories) Ctrl+click control+click

Selects all memories in a section Ctrl+A control+A
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Index

Numerics
1-24 button .................................... 10
25-48 button .................................. 10
49-72button ................................... 10
73-96 button .................................. 10

A
ALL CLEAR button ................ 23, 24
All Lib ............................................... 6
AUTO button ...................... 9, 11, 12
AUTO SETUP button ............ 23, 24
AUX section ................................... 18
Aux Section .................................... 11
Aux Send level section .................. 17
AUX SEND section ....................... 15
Aux Sends ...................................... 17

B
Balance & level section .................. 19
Bus Outs ......................................... 16
BUS section .................................... 18
BYPASS button ............................. 30

C
CH1-96 page .................................. 30
Channel fader .................... 11, 12, 13
Channel IDs ................. 23, 24, 25, 27
Channel Library ............................ 21
channel meter .......................... 11, 12
Channel number ............... 11, 12, 13
Channel Select ................................. 4
CHANNEL SELECT section

............ 14, 16, 17, 18, 19, 28
CLEAR button ............................... 22
CLOSE button ............................... 22
COMP button ......................... 10, 12
Compressor curve ................... 10, 12
Compressor Library ...................... 21
COMPRESSOR section

.................. 15, 16, 17, 19, 20
Configuring the Editor ................... 4
Confirmation ................................... 4
Console Device ID .......................... 4
Console Setup .................................. 5
Console->PC ................................... 4
Copy ................................................. 8
Creating a new Session ................... 7
Ctrl + click ....................................... 8

D
DELAY & PHASE section ............ 15
DELAY button .........................10, 12
Delay parameter .......................10, 12
DELAY section .............16, 17, 18, 19
Device Editor section ...................... 2
DIRECT button ............................ 10
Direct Out parameter ................... 10
Direct out patch page ................... 27
DIV.F control/DIV control .......... 28
DIV.R control (6.1 only) .............. 28
dry signal ....................................... 30

E
Effect editor window .................... 29
Effect Library ................................. 21
EFFECT NAME ............................ 29
Effect parameter section ............... 29
Effect patch page ........................... 26
EFFECT TYPE .............................. 29
Effects 1–2 page ............................. 30
Effects 1–8 page ............................. 30
Effects processor 1 section ........... 26
Effects processor 2 section ........... 26
Effects processor select ................. 29
Effects processors 3-8 section ...... 26
EQ button .................................10, 12
EQ curve ...................................10, 12
EQ FLAT button ........................... 31
Equalizer Library .......................... 21
EQUALIZER section 

...................15, 16, 17, 18, 19
Exiting Studio Manager ................. 3
extension ......................................... 7

F
FADER GROUP buttons

...................15, 16, 17, 19, 20
FADER GROUP section

.........................15, 16, 17, 20
Fader value indicator .....9, 11, 12, 13
File name ....................................... 22
FILE section ................................... 22
From Hardware .............................. 6

G
GATE button ................................ 10
Gate Library .................................. 21
Gate open/close indicators ........... 10
GATE section ................................ 14
Gate threshold ............................... 10

GEQ controls .................................31
GEQ display ...................................31
GEQ Editor Window ....................31
GEQ Library ..................................21
GEQ ON button ............................31
Graphic Equalizer ..........................31
Group Master Fader ......................13

H
host window ....................................3

I
IN button .......................................29
Index ...............................................33
Input Channels ........................10, 14
Input Patch Library .......................21
INPUT PATCH LINK ..................22
Input patch page ............................23
INPUT PATCH section ................14
Input Port/Output Port ..................4
INSERT button ........................10, 12
Insert In Patchbay .........................25
Insert Out Patchbay ......................25
INSERT parameter ........................31
Insert patch page ...........................25
INSERT section ..... 15, 16, 17, 19, 20
INTERNAL DATA section ...........22

K
Keyboard shortcuts .......................32

L
Launching Studio Manager ............2
LAYER button ................... 10, 12, 13
LAYER buttons ................................9
Layer Select ......................................4
Layer Windows ..............................10
level section ....................................15
LFE control ..............................11, 28
Library

Channel ....................................21
Compressor ..............................21
Effect .........................................21
Equalizer ...................................21
Gate ...........................................21
GEQ ..........................................21
Input Patch ..............................21
Output Patch ...........................21

LIBRARY button
...... 16, 23, 24, 25, 26, 27, 31
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LIBRARY section .......................... 14
Library Window ............................ 21
LIMIT buttons ............................... 31
LINK button (6.1 only) ................ 28
LINK buttons ................................ 31
Long channel names ... 23, 24, 25, 27

M
Master fader ..................................... 9
MASTER page ............................... 30
Master Window ............................... 9
Matrix Send level section .............. 18
Matrix Sends .................................. 18
Meter mode ................................... 30
Meter Window .............................. 30
Meters ........................................ 9, 29
MIDI port ........................................ 2
MIX BALANCE control ............... 30
MODULE parameter .................... 31
MUTE GROUP buttons 

.................. 15, 16, 17, 19, 20
MUTE GROUP section

........................ 15, 16, 17, 20

O
Offline .............................................. 9
Offline Edit .................................. 6, 9
Offline indicator .............................. 2
ON button ............... 9, 11, 12, 13, 16
Online indicator .............................. 2
ONLINE/OFF LINE button ........... 9
OPEN button ................................ 22
Opening a previously saved Session

............................................ 7
OUT button ................................... 29
Output channels ............................ 12
Output Patch Library .................... 21
OUTPUT PATCH LINK .............. 22
Output patch page ........................ 24

P
Pair icon ............................. 15, 16, 17
PAN CONTROL ............................. 9
PAN control .................................. 11
PAN section ................................... 15
Pan/Aux Send display ................... 11
Paste ................................................. 8
Patch editor window ..................... 23
Patchbay ............................. 23, 24, 27
PC->Console ................................... 4
PEAK HOLD button .................... 30
PHASE button ............................... 10

Port names ...................23, 24, 25, 27
POSITION parameter .................. 30
PROTECT ..................................... 22
protect any communication ports 6
PROTECT button ......................... 22

Q
Quitting Studio Manager ............... 3

R
RECALL button ............................ 22
Redo ................................................. 7
Remote Channels .....................13, 20
Remote target name ..................... 13
REMOTE1 ..................................... 13
REMOTE2 ..................................... 13
REMOTE3 ..................................... 13
REMOTE4 ..................................... 13
Re-synchronize ............................... 6
Resynchronizing Studio Manager . 6
ROUTING buttons ...................... 10
ROUTING section ........................ 15

S
SAVE AS button ........................... 22
SAVE button ................................. 22
Saving the current Session ............. 7
Saving the current Session with a 

new name ......................... 7
Scene number display ..................... 9
SELECT button ..............9, 11, 12, 13
Selected Channel Window ........... 14
Setup window ................................. 4
Short channel name .................11, 12
Shortcuts, keyboard ...................... 32
SOLO button ...........................11, 12
SOURCE parameter ..................... 10
Starting Studio Manager ................ 2
STEREO button .......................10, 12
Stereo Out ..................................... 19
Stereo page .................................... 30
STEREO section ............................ 18
STORE button .............................. 22
Surround editor window ............. 28
Surround mode parameter .......... 28
Surround pan graph ..................... 28
Surround pan position ................. 28
Synchronization .............................. 6
Synchronize ..................................... 6
Synchronizing Studio Manager ..... 6
System Setup ................................... 4

T
Timecode counter window ..........29
TITLE .............................................22
To Hardware ....................................6
TO STEREO section .....................16
Total Recall ......................................6

U
Undo ................................................7
UNDO button ...............................22
User Assignable Layer ...................13
User Defined ..................................13

V
View menu .....................................10

W
wet signal ........................................30
Window

GEQ Editor ..............................31
Layer .........................................10
Library ......................................21
Master .........................................9
Meter ........................................30
Patch editor ..............................23
Selected Channel .....................14
Surround editor .......................28
Timecode counter ...................29

window .............................................9
Window Control from Console .....4
WindowEffect editor .....................29
Workspace section ..........................2

Y
Y56K card .........................................7
Yamaha Web Site ............................1
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